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Copyright

Copyright 2010 by BenQ Corporation. All rights reserved. No part of this publication may be
reproduced, transmitted, transcribed, stored in a retrieval system or translated into any language or
computer language, in any form or by any means, electronic, mechanical, magnetic, optical,
chemical, manual or otherwise, without the prior written permission of this company.

Disclaimer

BenQ Corporation makes no representations or warranties, either expressed or implied, with
respect to the contents hereof and specifically disclaims any warranties, merchantability or fitness
for any particular purpose. Further, BenQ Corporation reserves the right to revise this publication
and to make changes from time to time in the contents hereof without obligation of this company
to notify any person of such revision or changes.

All other logos, products, or company names mentioned in this manual may be the registered
trademarks or copyrights of their respective companies, and are used for informational purposes
only.

Disposal of Waste Electrical and Electronic Equipment by users in

private households in the European Union.

This symbol on the product or on the packaging indicates that this can not be disposed
of as household waste. You must dispose of your waste equipment by handing it over to
the applicable take-back scheme for the recycling of electrical and electronic
equipment. For more information about recycling of this equipment, please contact
your city office, the shop where you purchased the equipment or your household waste
disposal service. The recycling of materials will help to conserve natural resources and
ensure that it is recycled in a manner that protects human health and environment.

CE Regulatory Notice

Hereby, BenQ Corp. declares under our responsibility that the product is in conformity with the
requirements set out in the Council Directive on the Approximation of the Laws of the Member
States relating, Electromagnetic Compatibility Directives (2004/108/EC) and Low Voltage Directive
(2006/95/EC).

A “Declaration of Conformity” in accordance with the above Directives has been made and is
available from BenQ Corp. upon request.



FCC Statement

This equipment has been tested and found to comply with the limits for a Class B digital device,

pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection

against harmful interference in a residential installation. This equipment generates, uses and can

radiate radio frequency energy and, if not installed and used in accordance with the instructions,

may cause harmful interference to radio communications. However, there is no guarantee that

interference will not occur in a particular installation. If this equipment does cause harmful

interference to radio or television reception, which can be determined by turning the equipment

off and on, the user is encouraged to try to correct the interference by one or more of the following

measures:

+ Reorient or relocate the receiving antenna.

+ Increase the separation between the equipment and receiver.

+ Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

+ Consult the dealer or an experienced radio/TV technician for help.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two
conditions: (1) This device may not cause harmful interference, and (2) this device must accept any
interference received, including interference that may cause undesired operation.

FCC Caution: Any changes or modifications not expressly approved by the party responsible for
compliance could void the user's authority to operate this equipment.



Safety warning and notice

Before operating the camera, please make sure that you read and fully understand the content in
this section. If you ignore and violate all safety warning notices indicated in this section, the camera
warranty may be void. Meanwhile, not only the camera but also you and all other people and things
around you may be severely damaged, injured, or even placed in danger of death.

For your safety

Keep the camera and its accessories out of the reach of babies, toddlers, and children. In
particular, small parts such as memory cards and batteries could be easily dismantled and
swallowed by them.

Use only the original accessories to avoid possible risks to health and property, and thus meet all
related legal regulations.

Do not dismantle the camera under any circumstances.

When using the flash, do not go too close to human eyes (particularly for babies, toddlers, and
children) or animal eyes. Otherwise, when the flash fires, the light may cause damage to human
eyes or irritate animals.

Batteries could explode, for instance. All batteries can cause property damage, injury or burns if a
conductive material such as jewelry; keys or beaded chains touch exposed terminals. The material
may complete an electrical circuit'and become quite hot. Exercise care in handling any batteries,
particularly when placing it inside your pocket, purse, or other container with metal objects. Do
not dispose of batteries in fire as they may explode.

To prevent electric shock, do‘not attempt to disassemble or repair your camera by yourself.
Some camera models accept non-rechargeable batteries. When using these batteries, do not
charge them. Otherwise, dangers such as explosion and fire may occur.

Warranty

Warranty is void if damage or system failure occurred due to outside factors such as collision,
fire, flood, dirt, sewage, earthquake, and other force majeure events as well as incorrect usage of
electricity or use of non-original accessories.

It is the sole responsibility of the user if problems (such as data loss and system failure) occurred
due to non-factory installed software, parts, and/or non-original accessories.

Do not change the camera. Any changes to the camera invalidate the warranty.

Taking care of your camera

Always keep the camera in a leather case or pouch for better protection against splashes, dust,
and/collision.

The only way of replacing the battery and the memory card is to open the battery/card cover.
Dispose of unwanted batteries and cameras as permitted by the laws in your countries.

Water may cause a fire or electric shock. Therefore, store your camera in a dry place.

If your camera becomes wet, wipe it with a dry cloth as soon as possible.

Salt or seawater may cause severe camera damage.

Do not drop, knock, or shake the camera. A rude behavior of using the camera may damage the
internal electronic circuit board, deform the lens shape, or make the lens unretractable.

Do not use harsh chemicals, cleaning solvents, or strong detergents to clean the camera.

Finger grease may be left on the camera lens and will result in unclear images or videos. To avoid
this problem, be sure to clean the camera lens before taking pictures or recording videos. You
should also clean the camera lens on a regular basis.

If the lens is dirty, use a lens brush or soft cloth to clean the lens.

Do not touch the lens with your fingers.



If a foreign substance or water gets in your camera, please turn the power off immediately and
disconnect the batteries. Next, remove the foreign substance or water and send it to the
maintenance center.

+ Whenever there is data in the internal memory or the external memory card, you should make a
backup copy to a computer or disc. So, you can have a backup solution if data loss occurs.

If the lens cannot retract into the camera, please replace the batteries first (usually this is because
of drained batteries). Then the lens should retract automatically. If the lens still cannot retract,
please contact your dealer.

+ Under no circumstances should you push the lens back manually as this may damage the camera.
All original accessories are designed only for use with this camera model you purchased. Do not
use these accessories with other camera models or cameras of other brands to avoid
unpredictable danger or damage.

Before initial use of a memory card, always use the camera to format the card first.

Remember to slide the write-protect tab (ifavailable) to the unlock position. Otherwise, all data
(if any) on the memory card is protected and the card cannot be edited or formatted.

Operating environment

+ Do not use or store your camera in the environments listed below:

+ Direct sunlight

+ Dusty places

+ Next to an air conditioner, eléctric heater or other heat sources

+ Ina closed car that is in direct sunlight

+ Unstable locations

Do not use your camera outdoors when it is raining or snowing.

Do not use your camera/in or near water.

The camera operating temperature is between 0 and 40 degrees Celsius. It is normal for the
operating time to be shortened when the temperature is low.

The capacity of your camera batteries will reduce each time it is charged/emptied.

Storage at too high or low temperatures will also result in a gradual capacity loss. As a result, the
operating time of your camera may be considerably reduced.

It is normal for the camera to become warm during operation, because the camera casing can
conduct heat.



Do not hold the camera by excessive
force. Plus, be sure to protect the
camera from strong impacts.

To avoid accidental falling, please attach
the hand strap to the camera and always
hold the camera by keeping the hand
strap around your wrist.

If the batteries suddenly depleted and
caused the lens fail to retract, please
carefully protect the lens to avoid
collision and insert batteries with full
power ASAP.

When the camera is not in use, always
turn the power off and make sure the
lens has retracted successfully before
storing the camera in its case. If you do
not intend to use the camera for a long
time, please remove the batteries

from the camera and store the batteries
carefully.

Keep your camera away from sharp
objects and avoid collision.

When the camera is not in use, please
place it in a steady place. Plus, always
keep your camera away from pressure
or any other similar environment

(for example, in a pant pocket) to
avoid possible damage.
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Touring the camera 1

Touring the camera
Checking the package contents

Carefully unpack your kit box and ensure that you have the following items.

English

1. User Manual or Quick
Guide
2. Digital camera
3. Non-rechargeable AA
o Alkaline batteries
4. Software & User
Manual CD
5. USB cable
6. Hand strap

User Manual

/
Quick Guide

+ All pictures, screen captures, and icons used in this manual are for illustration only. Actual
and available products, accessories, as well as their appearance may vary depending on
sales region.

+ If any items are missing or damaged, contact your dealer.

+ Save the packaging for future shipment or storage.

Camera
Front view and bottom view

O 0606 O
L

Shutter button

Power button

Flash

S.S.F. (Super Shake-Free) button
AF Assist Lamp / Self-timer LED
indicator

Speaker

Lens

Microphone

. Battery/card cover

10. USB/AV port

11. Tripod mount

(9] 1]
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2 Touring the camera

Rear view
o ® 0O 1. LCD display
o2 | | 2. W (Wide) W - Zoom-out, turn off
a’i / | the Shooting mode description, or
> a WD enter the thumbnail or calendar
i L — [4) view (Playback mode)
o O MMMMM | ) X
g | 3. T(Tele) T - Zoom-in or turn on
§ @—‘G the Shooting mode description
e~ 9@ 4. Status LED
™ @ 5 ) 5. MENU button MENU or return to
oisp 0 the previous menu
o ® / 6. FUNC / Delete button T FUNC -

Eo=>—0 Activate FUNC menu (Capture

mode) or delete photos (Playback

mode)

Strap eyelet

Multifunctional buttons (including a

4-way control and a SET button)

9. Mode switch - Toggle among
Capture (photo), Capture (movie),
and Playback modes

® N

Indicator State Description
Status LED No light The digital camera is off.
Solid green » The digital camera is ready to capture images.

» The digital camera is powering on, or is in the
power-saving mode.

Blinking green « The digital camera cannot focus.

» The digital camera is capturing a video clip.

« The flash is charging, or the USB communication/
transfer is in progress.

Self-timer LED | Blinking red The self-timer function is activated.

5 © ltis normal for the camera to become warm during operation, because the camera
casing can conduct heat.

The LCD display on this camera is manufactured with sophisticated technology, and
more than 99.99% of the pixels on the LCD display meet standard specifications. Yet, it
is possible that less than 0.01% of the pixels on the LCD display may have some light
spots or show unusual colors. This is normal and does not indicate display
malfunction, nor will this affect the pictures you take with the camera.

The LCD monitor looks darker in strong sunlight or bright light. This is not a
malfunction.

To prevent your images from being blurred while pressing the shutter button, always
hold the camera steady. This is especially important when you are shooting under low
lighting conditions, under which your camera may reduce the shutter speed to ensure
your images are properly exposed.




Preparing the camera for use 3

Preparing the camera for use

Use only the specified battery for the camera, and always turn off the camera before

removing the battery.

To install the battery:

1. Open the battery cover (A).

2. Insert the battery in the correct direction
by matching the + - label on the battery
slot (B).

Push the battery all the way down.
Close the battery cover (D).

English

o

To remove the battery:
1. Open the battery cover.
2. Pull the battery out (C).
3. Close the battery cover (D).

Please select the correct battery type before use (see "Battery Type" on page 27 for
details).

High-capacity (such as 2500 mAh) rechargeable batteries are recommended.
Carbon-zinc batteries are not recommended.

Remove the batteries from the camera if you do not intend to use the camera for a long
time.

If the lens cannot retract into the camera, please replace the batteries first (usually this
is because of drained batteries). Then the lens should retract automatically. (Under no
circumstances should you push the lens back manually as this may damage the
camera.) If the lens still cannot retract, please contact your dealer.

The AA batteries that came with the camera are not rechargeable.

.
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4 Preparing the camera for use

Using multifunctional buttons

You can choose camera settings by pressing the 4-way control or the SET button.

1.

Left/Focus: o
« Scrolls left in menus.

» Toggles between different focus modes. |
2. Up: (O
« Scrolls up in menus. /\
« Turns on/off Face Tracking. See "Face Tracking" on page @— ¥ @ $—
9 for details.
* Rotates an image. See "Rotating an image" on page 29 DISP
for details. \|
3. Right/Flash: o
« Scrolls right in menus. o
+ Selects a flash mode.
4. Down:
+ Scrolls down in menus.
5. SET: Confirms a chosen setting.
Using an SD card

The camera comes with internal memory for storing captured images, video clips, or audio
files. You can also add an SD card to store more files.

To install an SD card:

1. Make sure the camera is turned off.
- 2. Open the memory card cover.
3. Insert an SD card in the correct direction.

4. Close the memory card cover.

To remove an SD card:

1. Make sure the camera is turned off.

2. Open the memory card cover.

3. Lightly press the edge of the memory card
to eject.

4. Close the memory card cover.

(& Before initial use of an SD card, please format the card first by pressing MENU > |2-¢] >

Manage Memory > SET / i > E Format > SET > Yes.



Initial setting 5

Initial setting

You will be prompted to set up the language and the date and time when the camera is
turned on for the first time.

=
)
4
=
18}
=1
s8]

Setting language

Selects the language version shown on the screen.

To select a language:

1. Press MENU > € (Step 1 is needed only after the
initial setting is done.) Roména

2. Press Q ﬁ or DISP tolocate Language/:E% /i85 , e

and then press SET or 5

3. Press a i Q ﬁ or DISP to locate the language you want.
4. Press SET to set the language.

Setting date and time

When first time using the camera or the battery has been — %
removed from the camera for a long time, you need to set B 06/ 02 | 12:35
the date and time. They are used to record when a file was =

captured. YY /MM/DD

To set date and time:

1. Press MENU > |3 . (Step 1 is needed only after the
initial setting is done.)

g5 Enter =W Back

2. Press Q ﬁ or DISP to locate Date/Time, and then press SET or 5

3. Press Q !D or DISP to select date and time and date format. Press * or i to
move to another column as needed.
4. Press SET to set the date and time.
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6 Operating the camera

Operating the camera

The procedure below is a general guideline for basic operation. It is particularly useful if you

are new to the camera.

1.
2.

Press the Power button to turn the power on.
Slide the mode switch to a and press MENU > |!| !a DISP, * or 3 to locate

desired options (under two different tabs: i and |3-€|), and then press SET or i to
make selections.

(& Remember to follow the on-screen display or press | for instructions (wherever
available). Next, press corresponding buttons to access and set more options. At any time, you

can cancel the current operation by pressing MENU to return to your previous step.

3.

4.

oo

Press T to zoom-in or Y/ to zoom-out. (In the Movie Record mode, you can still adjust
the optical zoom before or during recording.)

Press the shutter halfway to set automatic focus. Once the focus is set, the focus frame
color will turn from white (unfocused) to green (focused). If the focus frame color is red and
you press the shutter down, it might result in a blurred photo.

Press the shutter down fully to capture.

Release the shutter.

7. Slide the mode switch to ;‘.. and enter the Movie Record mode. Next, adjust the optical

(=p

zoom as needed and press the shutter down to start video recording (press the shutter
again to stop video recording).

Slide the mode switch to m and view captured images or recorded videos. You can

press a or 3 to move to different images/videos, press T or W to zoom-in/out a
captured image, or press VW to view 9 files in the thumbnail view.
Press W again to view files in the calendar view (files created in the current month are

displayed by default). Here, you can press |!| !5 DISP, m to move to a thumbnail

and press SET to view all files taken on that day. Plus, you can also view files taken in
other months.

During zoom-in/out, there is a separator in the zoom bar between T and W. For
best image quality, it is recommended to use optical zoom only by keeping the

magnification within W and the separator.

Flash is automatically turned off in the Movie Record mode.

The Movie Record mode records both sound and video. The recording time is
continuous, but recording will stop once the memory card space is full.

In the Movie Record mode, sound is temporarily muted during zoom-in/out.

At any time, you can press the Power button to turn off the camera.

In Capture or Playback mode, press DISP to decide what information to show on the
screen.

Digital Zoom
I

Optical Zoom
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Capture mode

0 &HEL&GE W B

® & OOPPY

Item Description Page reference
1 Shooting mode 14
2 |Flash mode 9
3 Focus mode 10
4 Drive mode 19
5 |AEB 20
6 |[S.SF -
7 Number of shots available --
8 Image size 10
9 Image quality 10
10 |Face Tracking 9
11 |ISO 12
12 | White Balance 1
13 |AE metering 12
14 |Exposure value (EV) 1
15 |AF area 20
16 |Histogram -
17 |Battery status 26
18 |Camera shake warning -

=
[Z)
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8 Capture mode

(-

In the Capture mode, press DISP to toggle among 5 display modes (standard,
complete, none, rule of thirds, and Help Screen).

Use the rule of thirds display mode to improve your composition by placing subjects on
at least one of the intersections of these 4 imaginary lines.

Help Screen diagram provides a quick overview to the major functions of camera
buttons.

While the shutter is pressed halfway, the shutter speed and the aperture are also
shown on the screen (not available in the Movie Record mode).

While the shutter is pressed down halfway, the AF area color changes to yellow-green,
camera shake warning (appears only if the camera itself detects possible shaking),
aperture, shutter speed and ISO setting are also shown on the screen.

More capture options in the Function menu

Press the Function button Jg FUNC to access more capture options. Depending on your
settings, the displayed option icons in the Function menu may vary.

F! You can set the shooting

2M

My Mode

(the 6 most recent
record modes, in
the order used)

parameters. Resolution

Image Quality

Exposure Value
(EV)

White Balance
1ISO
Metering
Effect

To use the Function menu:
1. Press T FUNC to enter the Function menu and currently selected setting shows.

2. Press |!| ﬁ DISP to go to another option, or press w or i to select a setting.
3. Press SET to confirm the setting.
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Flash mode

The flash offers an additional light source (usually used in a low-light environment). You
can capture an image using one of the following flash modes.

Icon

Mode

Description

%

Auto Flash

The flash fires automatically based on the photographic
conditions.

@

Auto Anti Red-eye

Reduces the red-eye phenomenon when capturing
natural-looking images of people and animals in low-light
conditions. Be sure to ask the subject to look at the
camera lens or get as close to the camera as possible.
The flash fires automatically based on the photographic
conditions.

Force On

The flash always fires regardless of the surrounding
lighting conditions. Select this mode when capturing
images with high contrast (backlighting) and deep
shadows.

%

Slow Sync

Fires the flash immediately at the beginning of exposure
with a longer shutter speed, so balanced ambient
lighting of the foreground subject and background scene
can be reached in a low-light environment.

Force Off

The flash does not fire. Select this mode when flash
photography is prohibited, or when the distance to the
subject is beyond the effective range of the flash.

To select a flash mode:
1. Go to the Capture mode.

2. Keep pressing i to toggle among different flash modes and select a desired option.

Face Tracking
Focuses on the position of faces (max. 10 faces) simultaneously. While using the Face
Tracking function, point the camera to where the people (your subjects) are located. Focus
frames of Face Tracking will automatically detect faces (maximum 10) and show on the

LCD screen.

5 * Due to environmental factors such as lighting, the number of detected faces might be
different from that of the actual faces.

+ To achieve the best result, ask your subjects not to turn their faces partially away from

the lens.

English
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10 Capture mode

Focus mode
Icon Mode Description
Auto focus Adjusts focus automatically.
(5]
@ Macro Used when capturing images at a close distance.
Pan Focus Used when you want to capture the subjects in a certain focus
(6]
range.
[E-'Aj] Infinity Used when capturing images at long distance.

To select the focus mode:

1. Go to the Capture mode.

2. Keep pressing a to toggle between Auto focus and focus modes.

Image size
Icon Description Icon Description
14 megapixels (4320 x 3240 3 megapixels (2048 x 1536
gapixels ( ) gapixels ( )
) 3:2 (4320 x 2880) HD 16:9
E (1920 x 1080 in full HD format)

8 megapixels (3264 x 2448)

VGA (640 x 480)

o
m 5 megapixels (2592 x 1944) -- --
To select an image size:
1. Press [ FUNC > Resolution.
2. Press a or i to select a setting.
3. Press SET to confirm setting.
Image quality
Icon Mode Description
...... Super Fine Best image quality with the lowest compression rate. File size is
p ge q y p

the largest.

Fine Better image quality with medium compression rate. File size is
medium.
Normal Good image quality with the highest compression rate. File size

is the smallest.




Capture mode 11

To select an image quality level:
1. Press [f FUNC > Image Quality.

2. Press $ or i to select a setting.
3. Press SET to confirm setting.

Setting EV

EV (Exposure Value) lightens or darkens the entire image. Adjust EV when the brightness
between the subject and the background is not balanced, or when the subject occupies only
a small part of the picture.

English

To select an EV:
1. Press [f FUNC > EV.

2. Press * or i to select an EV
from the EV bar. The preview
result based on the currently
selected EV is shown in the
middle thumbnail.

3. Press SET to confirm setting.

Currently
selected EV

Middle thumbnail

White Balance

Compensates for color temperatures in different lighting conditions, so white and other
colors can display properly when you capture images.

Icon Mode Description

5% Auto Adjusts white balance automatically.

Foe Daylight Used in bright daylight conditions.

Cloudy Used in twilight or shady conditions.

ok

Tungsten Used when subjects lit by tungsten (incandescent) lighting.
Sase Fluorescent H Adjusts for fluorescent lighting. Corrects the green hue of
-7vH fluorescent lighting. Ideal for indoor photos under

fluorescent lighting without a flash.
sizg Fluorescent L
i

Manual Used when you want to manually adjust white balance in a
particular lighting condition.
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12 Capture mode

To select White Balance:
1. Press [ FUNC > White Balance.

2. Press $ or i to select a white balance option. The preview result based on the currently
selected white balance is shown in the middle thumbnail. (When selecting the manual
mode, you must first point the adjustment frame shown on the screen at a blank sheet of
white paper or something similar, and press the Shutter for the camera to detect proper
colors.)

3. Press SET to confirm setting.

ISO

ISO configures the camera’s sensitivity to light. The higher the ISO value, the brighter
picture you can take in a low-light environment. Yet, you may see more noise in the picture
as you increase the ISO value.

Icon Description
Automatically sets the ISO value.
A
Equivalent tolcolo_r 1ISO 10.0/200 film. Used for outdoor
100 §1 200 photography in bright sunlight.

Equivalent to color ISO 400/800/1600/3200/6400 film. Used it in
lIsO] [iso] [isO]
a low-light environment or where the flash light is not allowed.

150] « ISO 3200 for resolution of 3M or under only
6400 + 1SO 6400 for resolution of 3M or under only

To select an ISO value:
1. Press [ FUNC > ISO.

2. Press a or i to select an ISO Value.
3. Press SET to confirm setting.

AE metering
Icon Mode Description
() Matrix Detects the exposure based on multiple points in
the subject area.
- he subj

(=) Cent. Weight (Center Weight) |Detects the exposure of the entire shooting
screen, but gives more importance to the values
near center.

Spot Detects the exposure based on the center spot in
(-] the subject area.

To select an AE metering option:
1. Press [ FUNC > Metering.

2. Press * or i to select an AE metering option.
3. Press SET to confirm setting.
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Effect
Adds color filter effects to the image or video you want to capture.
Icon Mode Description
Normal No effects are added.
LOMO (For Movie Record only) Creates a lomo-like effect by
adding over saturated colors, dark corners, and so on.

Vivid Adds an effect with very clear and bright color tones.
Sepia Adds an effect with dark reddish brown color tones, so

the image or video looks as if it is old.

B/W (Black and White)

Adds an effect with monochromatic color tones.

Vivid Red The image becomes reddish.
Vivid Green The image becomes greenish.
Vivid Blue The image becomes bluish.

Color Accent (Red)

Highlights the subjects by keeping the red color domain of
an image only while making other regions black and
white.

Color Accent (Green)

Highlights the subjects by keeping the green color
domain of an image only while making other regions
black and white.

ARSI RSOSSN N

Color Accent (Blue)

Highlights the subjects by keeping the blue color domain
of an image only while making other regions black and
white.

Before

After - when Color Accent (Red) is applied

English
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14 Capture mode

After - when Color Accent (Green) is applied After - when Color Accent (Blae) is applied

To select an effect:
1. Press [ FUNC > Effect.

2. Press * or i to select an Effect option. The preview result based on the currently
selected effect is shown in the middle thumbnail.

3. Press SET to confirm setting.

Shooting mode
Select one of the following shooting modes to fit your shooting condition.
Icon Mode Description
Auto Mode The camera automatically decide most settings,
S0 you can capture images with ease.
Smart Scene Automatically selects a shooting mode based on
the current shooting environment.
Program You can set the shooting parameters manually.

Aperture Priority

You can choose an aperture value, while the
shutter speed is automatically determined by the
lighting condition of the subject.
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Shutter Priority You can choose a shutter speed, while the
aperture value is automatically determined by the
lighting condition of the subject.

Manual Lets you set both aperture and shutter speed
manually.

Smile Catch Automatically takes a shot when a smile is

detected.

Blink Detector

Warns of eye blinks if detected & lets you decide
whether to save the image file.

Portrait Makes the subject (usually a person) stand out
with smooth and natural-looking skin tones.

Landscape Captures a scene in the distance with the focus
area set to infinity and a lower aperture value. The
maximum depth of view can also be achieved.

Sports Uses a high shutter speed to capture objects in
motion.

Backlight Increases exposure (by turning on the flash) when
light illuminates the subject from behind.

Night Scene Captures photos in a low-light environment, such

as in the evening or at night.

English
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Night Portrait Shoots night scenes and portraits clearly. Please
keep the camera steady or use a tripod while
using this mode.

Self Portrait Takes a self portrait with at least one face in a

confined area.

Love Portrait

Takes a self portrait with at least two faces in a
confined area.

Pre-composition

Captures the background first, so the helper can
use it to take the final shot.

HDR Increases the dynamic range and enhances the
details of dark areas.

LOMO Creates a lomo-like effect by adding over
saturated colors, dark corners, and so on.

Fisheye Simulates a fisheye lens effect and creates a
distorted hemisphere-like image.

Snow Used under a very bright light environment such
as snow scenes.

Fireworks Adds exposure time to shoot firework trails.

Please keep the camera steady or use a tripod
while using this mode.
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Building Enhances lines & contracts to highlight the sense
of the three dimensions (3D) for a building.

English

Soft Flowing Water |Uses a low shutter speed for motion blur. Please
keep the camera steady or use a tripod while
using this mode.

Web Auction Reduces the file size for faster internet upload.

Beauty Enhancer Enhances the tone of skin so that the facial skin
appears smooth.

Food Captures food by enhancing color brightness and
giving more vivid colors.

Candle Light Makes a picture look warm, and thus captures the
mood under candle light source. Flash is always
off.

Party Captures the party atmosphere usually under

indoor light source.

Text Improves clarity & contrast when taking a close-up
picture of documents.

Child Increases sensitivity and emphasizes children's
| skin tones.
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Foliage Takes a clear and vivid picture of flowers or plant
leaves by emphasizing their saturation and
sharpness.

o]
o
a,
5 Sunset Captures the warmth and atmosphere

(represented by hue) of sunrise or sunset.

Voice Rec. (Voice Captures background sound only (no images or

Record) videos). When listening to the captured audio file
later, you can see a unique icon that appears on
the screen and indicates that this is an audio file.

& * ISO, Metering, and White Balance are not available in some shooting modes like Auto
Mode. You must select another mode like Manual to enable these options.
* When S.S.F. is turned on, adjusting ISO is unavailable no matter which shooting mode
you select.

To select a shooting mode:

1. Press MENU > (@) > Shooting Mode > i

Shooting Mode
Sports

Night Scene
Night Portrait
Self Portrait

gSelect 0ED Back B Info

2. The currently selected shooting mode shows. Press I!' ﬁ or DISP to locate another
desired option.

(3 When you are selecting from different shooting modes, press T for detailed explanation

of each shooting mode. Press W to close the shooting mode description when you are done.

3. Press SET to confirm setting.

Aperture Priority
Aperture priority is often used when shooting static subjects or emphasizing the depth of
field. In general, use a smaller aperture if a greater depth of field is needed.

To adjust aperture value:
1. Go to the Capture mode with Aperture Priority mode selected.
2. Press SET.
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3. Press |!| !5 / DISP to adjust the aperture value.
4. Press SET to confirm setting.

Shutter Priority
Shutter priority is often used when shooting moving subjects. In general, use a shorter
shutter speed to catch a fast-moving object.

English

To adjust shutter speed in Shutter Priority:
1. Go to the Capture mode with Shutter Priority mode selected.
Press SET.

2
3. Press * / 3 to adjust the shutter speed.
4. Press SET to confirm setting.

Manual mode
You can choose the aperture value and shutter speed in Manual mode.
To adjust values in Manual mode:

1. Go to the Capture mode with Manual mode selected.
2. Press SET.

3. Press |!| !5 / DISP to adjust the aperture value, or $ / i to adjust the shutter
speed.
4. Press SET to confirm setting.

& When toggling between Av/Ty, press the shutter halfway for exposure metering.

Drive mode

Icon Mode Description
o Off (Single) Takes one picture at a time.

Self-timer Automatically takes a picture after 2 or 10 second delay.
This mode is useful when you want to be part of the
picture.

D Double Performs delay and capture twice:
= 1. Performs a 10-second delay, then captures the
image.
2. Performs another 2-second delay then captures the
image again.
Burst Continuously takes pictures as long as you keep

&

pressing the Shutter. The flash is always off in this mode.

Speedy Burst Press and release the shutter. When the photo size you
select is VGA, Speedy Burst will shoot continuously at
the speed of 30 shots per second. This will stop after 1
second or when the memory card is full.

2P
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To select a drive mode:
1. Go to the Capture mode.

2. Press MENU > | > Drive Mode.

3. Press SET or i and then select a desired option.
4. Press SET > MENU.

Auto Exposure Bracketing (AEB)

The AEB function automatically takes 3 pictures with slightly different settings in the
shutter speed or the aperture value.

To turn on/off AEB:

1. Go to the Capture mode.

2. Press MENU > 1] > AEB.

3. Press SET or i and then select m or .
4. Press SET > MENU.

AF area
Icon Mode Description
Wide Focuses on a wide range of multiple objects.
gt
(+] Center Focuses on the center area of the objects.

To select an automatic focus area:
1. Press MENU > | 1) > AF Area.

2. Press SET or i and then select a focusing area.
3. Press SET > MENU.

AF Assist Lamp

This function emits red light allowing the camera to focus easily when half pressed the
Shutter button.

To turn on/off AF Assist Lamp:

1. Go to the Capture mode.

2. Press MENU > (] > AF Assist Lamp.

3. Press SET or i and then select m or .
4. Press SET > MENU.
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Setting sharpness, saturation and contrast

Adjusts how colors appear in the pictures by setting sharpness, saturation, and contrast.

To set sharpness, saturation, or contrast:
1. Press MENU > ||, and then select Sharpness, Saturation or Contrast.

English

2. Press SET or i and then select High, Normal, or Low.
3. Press SET > MENU.

Digital Zoom

The digital zoom enlarges or shrinks the image using a software process.

Icon Mode Description

Wise Zoom Reduces the image size, and thus increases the effective
zoom length without sacrificing image quality.

Digital Zoom | Turns on the digital zoom feature.

OFF Turns off the digital zoom feature.

To select a digital zoom:

1. Press MENU > | > Digital Zoom.

2. Press SET or i and then select a digital zoom type or i
3. Press SET > MENU.

Date Stamp
Imprints the date when a picture was taken on the picture itself.
To set the date stamp:

1. Press MENU > |} > Date Stamp.
2. Press SET or i and then select Date, Date & Time, or .
3. Press SET > MENU.

Instant Review
This feature displays the still image that just recorded for 1 second.
To set the Instant Review:

1. Press MENU > || > Instant Review.

2. Press SET or i and then select m or .
3. Press SET > MENU.

=y During instant review, half press the shutter to return to the capture mode.
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Smart Scene

(AuTO|

Automatlcally selects the best shooting mode from Portrait . Landscape oy, Sunset

, Backlight , Backlight Portrait |Gy , Night Portrait [g5, Night Scene g &, Snow

AUTO (auTO)
. Text . Foliage . and Macro g -

1. Press MENU > [n} > Shooting Mode and select .

2. Press the shutter halfway to set automatic focus. The selected shooting mode is displayed
in the top left corner of the screen.

3. Press the shutter to capture an image.

Blink Detector

Automatically detects blinking when you capture an image.

1. Press MENU > [ | > Shooting Mode and select Blink Detector.
2. Press the shutter to capture an image. If blinking is detected, a warning message appears
on the screen.

3. Press |!| ﬁ / DISP to save or discard the image, and then press SET to confirm.

Love Portrait
Takes a self portrait of at least two faces.

1. Press MENU > [ > Shooting Mode and select Love Portrait.

2. Once faces are detected, the camera will automatically take a picture after a two-second
countdown.

(S During the countdown, you can press the shutter to cancel the countdown. The camera

will then start detecting faces again.

3. The camera continues to detect faces and take more pictures by repeating Step 2. This
face tracking will automatically stop if no faces are detected.

Pre-composition
Captures the background first for positioning the final image. Ideal for asking others to take
your photo.

1. Press MENU > x| > Shooting Mode and select Pre-composition.

2. Press the shutter to capture the background. The bottom section of the screen displays the
captured background image in a semi-transparent region.

3. Use the captured background image to frame the composition, and press the shutter to
capture the final image.

Smile Catch

Captures an image when the subject smiles.

1. Press MENU > [ > Shooting Mode and select Smile Catch.

2. The camera is tracking the face of your subject (a white frame shows).

3. Once a smile is detected, the camera instantly takes a picture.

4. The camera continues to detect smiles and takes more pictures (Step 3 is repeated).
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@ Face tracking (one face only) is always on in the Smile Catch mode.

LOMO

Creates a lomo-like effect by adding over saturated colors, dark corners, and so on.

=
[Z)
o=
-_
Y]
=1
53}

1. Press MENU > || > Shooting Mode and select LOMO.
2. Take a picture. (The LOMO effect will be applied to this picture immediately.)

@ When the LOMO effect is applied, color shift (changes in colors) might occur.

\

Before

Fisheye
Simulates a fisheye lens effect and creates a distorted hemisphere-like image.
Creates a lomo-like effect by adding over saturated colors, dark corners, and so on.

1. Press MENU > = > Shooting Mode and select Fisheye.
2. Take a picture. (The Fisheye effect will be applied to this picture immediately.)

|

.

Before
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Web Auction

Combines maximum 4 shots into one single image at the VGA (640 x 480) size, so it can be

esfl quickly used in situations such as Internet auctions.
=]
Gf—, 1. Press MENU > x| > Shooting Mode and select Web Auction.
w
=
2. Press $ or i to move to the number of shots you want to take, and then press SET .
Icon Mode Description
@ 1 shot Takes one picture only.
1
2 shots Takes two pictures based on the numeric order shown below:
1 2
3 shots Takes three pictures based on the numeric order shown below:
2|
1 3
4 shots Takes four pictures based on the numeric order shown below:
1 2
k] 4

3. Press the shutter to take one picture.
4. If you are satisfied with the this picture, press SET to take the next one. (If you want to re-

take the previous picture, press MENU and repeat Step 3.)
5. Once you have finished taking all pictures, the camera will automatically combine these

images into one.
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Movie Record mode settings

Icon

Description

HD
=
VGA

Video Format: HD 720p (16:9; 1280 x 720), VGA (640 x 480), QVGA

(320 x 240), or Web sharing (640 x 480).

» Recording a video at HD 720p (16:9; 1280 x 720) requires a Class 6 or
above SDHC card.

* The maximum length of a video recorded at HD 720p (16:9; 1280 x
720) is 29 minutes.

* Videos captured in Web sharing mode are stored under the
XXXUTUBE directory (XXX are numbers) with the file size limited to 1
GB or 10 minutes per video file (video recording will automatically
stop).

Y] [y
5

Niv
:&: =S
@2 | S| ST

White Balance: Auto, Daylight, Cloudy, Tungsten, Fluorescent H,
Fluorescent L, or Manual. See "White Balance" on page 11 for more
details.

AE metering: Matrix, Center, Spot. See "AE metering" on page 12 for
more details.

Effect: Normal, LOMO, Vivid, Sepia, B&W, Vivid Red, Vivid Green, Vivid
Blue, Color Accent (Red), Color Accent (Green), Color Accent (Blue).
See "Effect” on page 13 for more details.

Pre-record: On and Off

When Pre-record is on @ the camera repeats recording a short
video clip for a 3-second duration before you press the shutter. Once
you press the shutter, the previous 3-second video clip will be combined
into the current video you are shooting.

(3 Only the latest 3-second video clip is stored temporarily on the
memory.

To select a Movie Record option:

1. Slide the mode switch to ;’-. and enter the Movie Record mode.

2. Press T FUNC, and then select an option.

3. Press $ or i to select a setting.
4. Press SET to confirm setting.

English
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Battery status
Icon Description
Battery power is full.
Battery power remains adequate.
Battery power is low.
a Battery power is very low. You should replace the battery ASAP.

Other settings

Press MENU > [3:€), and then select an option.

Option Description
Sounds [Startup] Sets a type of the startup sound.
[Shutter] Sets the shutter sound on and off.
[Operation] Sets the operation sound on and off.
[Volume] Adjusts the volume of the shutter sound, startup

sound, operation sound and playback sound.

Power Saving 1 . For power conservation, the camera automatically
m [1 min.] enters the standby mode after it has been idle for

J— a period of time. (Press any key to resume.)

m [3 min.]

B2 5 min]

1 The camera remains on when idle.
& o
LCD Saving E o For power conservation, the LCD screen is
[On] automatically dimmed after the camera has been
idle for 20 seconds. (Press any key to resume.)
1 The LCD screen remains bright when the camera
or [l is idle.
Date/Time Sets the date and time.

Select a language for display menus and other information.

Language / ;85 | iE5
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File Numbering

@ [Series]

Stores the most recently used file number
regardless of deleted files or a change of memory
card. This is useful for avoiding the file name
duplication when images are downloaded to a
computer.

[Reset]

Resets file numbering each time the memory card
is changed.

TV Format

You can review images on a television with an AV cable.

INTSC]

America, Japan, Taiwan and others

China, Europe, Oceania, and others

[PAL]

& TV Format s

your region. For details about which system should be used, check
with your local authorities.

hould be set to either NTSC or PAL depending on

LCD Brightness

The LCD brightness is automatically set based on
the surrounding environment.

The LCD brightness is increased.

[Normal]

The LCD brightness remains at the default value.

Battery Type To ensure the camera displays battery level correctly, set the type to
match the batteries used. Carbon-Zinc batteries are not
recommended.

o | When using Alkaline batteries.

[Alkaline] 9

o | When using NiMH batteries.
i [NiMH] 9

[Lithium]

When using Lithium batteries.

Manage Memory

E [Format]

Formats the internal memory or the memory card.

@ [Copy to
Card]

Copies files from the internal memory to the
memory card.

Reset All

Resets the entire
default.

menu and button operation settings to initial

English

The following settings do not change after Reset All:
Date & Time setting

Language setting

TV Format setting
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Playback mode

Slide the mode switch to m and enter the Playback mode.

(3 While pausing video playback, you can press the shutter to capture the video frame as a

(6]

08:05
G

IMG 0064.JPG
1.25MB

1/200 F2.8

A 50 k00 ¥ [m]

still image in the VGA format.

0— 3] 01952 T —0

Item Description Page reference
1 Indicates that the camera is in the Playback mode. -
2 Indicates that the file is protected and cannot be deleted. 31
3 Indicates this file has a voice memo or the file is an 32

audio file.

4 Indicates the file is marked for printing. -
Displays the shooting parameters when you took the -
picture or playback controls. Press DISP to toggle
between different displayed information.

6 Date and time when the file was created. -

7 File number -

8 Histogram -

9 File name, file size, shutter speed, and aperture value -
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Options for playback and editing

When the camera is in the Playback mode, press a, or i to move to different files. You
can also select any of the following options.

English

Enlarging an image

Magnifies an image, so more details can be seen.

To enlarge an image:

1. Slide the mode switch to E]

Press $ or i to move to the image you want to enlarge.
Press T to zoom-in or W to zoom-out.

2
3.
4. Press |!| QD, DISP, $ or i to move to the area you want to see.

5. Press MENU to return to the normal viewing size.

Rotating an image

You can press |!| !a to change the orientation of an image at 90 degrees clockwise at a
time.

(3 For each rotation, the image file in the new orientation is automatically saved.

Viewing multiple files at a time

Shows up to 9 files at a time on the screen.

To view multiple files:

1. Slide the mode switch to E]

2. Press WY . In this mode, maximum 9 files (shown in thumbnails) are displayed on the

screen. Press |!| !5 DISP, $ or i to select a file, and then press SET or
MENU to view it in its normal viewing size.

3. Press W. In this mode, all files are arranged by dates. Press I!' !E DISP, $ or

i to select a file, and then press SET or MENU to view it in its normal viewing size.

(S If there are more than 9 thumbnails, you can press i repeatedly until the scroll bar is

highlighted. Then you can press I!' !E to move to the previous 9 thumbnails or DISP to

move to the next 9 thumbnails. To cancel highlighting the scroll bar, just press *
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Playing back video clips

View recorded video clips in the playback mode.
To view a video clip:

1. Slide the mode switch to E

2. Press $ or i to move to the video clip you want to view.
3. Start playing back.
* Press SET to start playing the video clip.

+ Press DISP to stop the video clip, or press |!| !5 to pause it. Press |!| !5 again

to resume.

* During video playback, press i to fast forward or press $ to rewind.
» While pausing video playback, you can press the shutter to capture the video frame as
a still image in the VGA format.

» While pausing video playback, you can view the video frame by frame. Press i to fast
forward one frame, or press a to rewind one frame. Press and hold 3 to fast

forward frame by frame continuously, or press and hold a to rewind frame by frame
continuously.

Adjusting the playback volume
Increase or decrease the volume of video clips, audio clips, or voice memos.

To adjust the playback volume:
1. Turn the power on, and set the camera to the playback mode.

2. Press a or 3 to select a video clip, audio clip, or voice memo that you want to playback.
3. Adjust the volume.

« Press | to increase the volume.

« Press W to decrease the volume.
(3 The volume can be set during playback, but not during rewind, fast forward, or pause.

Slideshow

Sets the time interval for presenting a series of captured image and video files (first frame
only).

To play a slideshow:

1. Slide the mode switch to E

2. Press MENU > | =) | > Slideshow > SET or i
3. Change the slideshow settings.
+ Use the four-way control to set one of the following slideshow effects:

. Applies a transition effect from left to right.
. Applies a transition effect from upper-left side to lower-right side.
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. Applies a horizontal transition effect.
. Applies a vertical transition effect.

. E Applies a horizontal transition effect by intersecting an image.

* You can set the interval between 1/3/5/10 seconds.
4. Select whether you want to repeat the slideshow.

5. Select Start and press SET to play the slideshow.

(3 If you want to pause it at any time, press SET. Press SET again to resume playback. To
stop the slideshow, press MENU.

Deleting files

Removes selected or all files.

English

To delete files:
1. Slide the mode switch to m

2. Press MENU > =) | > Delete > SET or i
3. Select whether to delete this selected file, other selected, all files, or voice memo only, and
then press SET .

Protecting files
Prevents selected files from accidental removal.

To protect files:

1. Slide the mode switch to m

2. Press MENU > | =) > Protect > SET or i
3. Select whether to protect this selected file, other selected, or all files, and then press SET .
You will then see the icon & indicating the file is protected.

(3 You can remove the protection anytime by following the same procedure as shown above.
Note that in Step 2 the on-screen instruction will ask you how you want to remove the
protection.

Red-eye Removal

The Red Eye Correction function is used to reduce red eye in captured images. This function
is only available for still images. Red eye correction can be applied to an image several times,
but the quality may gradually deteriorate.

1. Slide the mode switch to m

2. Press $ or i to move to the image you want to apply Red-eye Removal.

3. Press MENU > | =) > Red-eye Removal > SET or i
4. Press SET to confirm the change and save the image file.
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Voice memo

Inserts a voice annotation to an image file.
To record a voice memo:

1. Slide the mode switch to E

Press $ or i to move to the image you want to add a voice memo.

Press MENU > [=) > Voice Memo > SET or i
Select Start > SET to start recording your voice.
Select Stop > SET to stop recording.

SIS

To play back a voice memo:
1. Press SET to play the voice memo.

2. Press [.'.] !E] to pause the playback.

3. Press [@] 6 to resume the playback.
4. Press MENU to exit playback.

Photo Effect
You can add special effects to your images.
Icon Option Description
Normal No effect is added to the image.
Sepia Recorded image will be stored in a sepia tone.
B/W Convert image to black & white.
Negative Colors become the opposite of what they were in the original
image.

Mosaic Applies a mosaic tile effect to the image.

Vivid Red The image becomes reddish.

Vivid Green |The image becomes greenish.

Vivid Blue The image becomes bluish.

AN NE AN

To add a special effect to an image:

1. Slide the mode switch to m

2. Press * or i to move to the image you want to add an effect to.
3. Press MENU > [[&] > Photo Effect > SET or i

4. Press w or 5 to select the effect. The preview result based on the currently selected
effect is shown in the middle thumbnail.
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5. Press SET to confirm the change and save the image file.

Photo Effect

English

Trimming
Crops part of an image file, reduces the image size, and overwrites the image file or saves it
as another new file.

To trim an image:

1. Slide the mode switch to m

2. Press m or i to move to the image you want to trim.

Press MENU > [&)| > Trim > SET or 3

Press T or W to select the target image size (8M, 5M, 3M, VGA) to which you want to
reduce.

5. Press Q ﬁ DISP, $ or i to locate the area to trim.

6. Press SET to confirm the change and save the image file.

@ You cannot trim images in the size of 3:2, 16:9, or VGA.

Resizing

Changes an image file to a smaller size, and overwrites the image file or saves it as another
new file.

To resize an image:

1. Slide the mode switch to m

2. Press a or i to move to the image you want to resize.
3. Press MENU > [ > Resize > SET or i

4. Press I!' ﬁ or DISP to select the target image size to which you want to reduce.
5. Press SET to confirm the change and save the image file.
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Startup image
Sets the welcome screen when the camera is powering on.

To select a startup image:

1. Press MENU > @ > Startup Image > SET or i
+ To use the default startup image, select Default.
 To use a custom image, select My Photos and press $ or i to select an image.
+ To disable the startup image, select Off.

2. Press SET.

DPOF

The Digital Print Order Format (DPOF) setting allows you to select images on the memory
card for printing and specify the number of print copies in advance using the camera. This
is extremely convenient for sending the images to a photo developing service or for printing
on a direct print function compatible printer.

To set up DPOF:

1. Press MENU > | = > DPOF.
2. Press I!' I or DISP and select one of the following options.
* To set the DPOF setting for one image in a time, select One. and press $ or i to
select an image.
+ To set the DPOF setting for all images in a time, select All.
* To clear all DPOF settings to initial default, select Reset.
3. Press |!| !5 or DISP to specify the number of copies.
4. Press T FUNC to decide whether you want to turn the date stamp on.
5. Press SET.
Radial Blur

Applies a rotating motion effect to give a feel of speed.

To apply a Radial Blur effect:

1.

2.

w

o &

Slide the mode switch to m
Press * or i to move to the image you want to add a Radial Blur effect.
Press MENU > | = | > Radial Blur > SET or i

Press |!| !5 or DISP and select a degree of Radial Blur.
Press SET to confirm the change and save the image file.
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Working with computer and AV system
Bundled software

The camera offers the following programs on a CD.

English

ArcSoft Combines photo editing with creative enhancement and sharing tools
Photolmpression 5  |that maximize your digital media experience.

ArcSoft Creates multimedia presentations by combining photos and video
Videolmpression 2 clips with audio, text and scene transitions.

To install these programs, see the information supplied with the CD.

Connecting the camera to a computer
You can connect the camera to a PC or notebook to transfer, view, print, or edit files.
To connect the camera to a computer:

1. Connect the end of the smaller plug of the USB cable to
the camera.

2. Turn on the camera.

3. Connect the other end of the USB cable to an available
USB port on your computer.

4. Select Computer and wait for the connection.

5. A Removable Disk icon appears in My Computer. Click
this icon to access the files in your camera.

3 * When connecting the camera to a computer, it is necessary to install batteries into the
camera.
* When connecting the camera to a computer, please use the original accessory of the
USB cable to avoid possible system conflicts and damage to the camera.

Connecting the camera to an AV system

You can play files in your camera from an AV system such as TV or projector.

To connect the camera to an AV system:

1. Connect the end of the smaller plug of an AV cable to the camera.

2. Connect the yellow video plug and the white audio plug of the AV cable to a video-input jack
and an audio-input jack (left channel) on your AV system.

3. Turn on the AV system, and then switch to the AV source connecting to the camera.

4. Turn on the camera.

5. Follow the on-screen instructions to operate the camera via the TV or projector screen.

Printing images

In addition to printing images by connecting the camera to a printer via a computer or
bringing the memory card (if available) to a photo-processing center, you can choose to
print using PictBridge.

Printing with PictBridge

You can directly print images by connecting your camera to a PictBridge-compatible
printer without using a computer.
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To print images from a PictBridge-compatible printer:

oahwh=

7.

Connect the end of the smaller plug of the USB cable to the camera.

Connect the other end of the USB cable to an available USB port on your printer.
Turn on the printer. Wait for a while until it finishes starting up and is ready to print.
Turn on the camera.

Select Printer and wait for the connection.

Select one of the following options:

+ To print one image in a time, select Print One, and press * or i to select an image.

« To print all images in a time, select All.
* To print all images (shown by thumbnails) in a time, select Index.
Press SET.

& * The above procedure may vary depending on the printer type you are using.

« If you connect the camera to your printer while the printer is still starting up, the
camera will be automatically turned off.

+ Failure to follow the above procedure will make the camera show an error message.
Please disconnect the camera and the camera will be automatically turned off.
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Troubleshooting and service information

If your camera cannot operate normally, see the frequently encountered problems and
solutions listed below. If the problem persists, contact your nearest service center or

technical support.

Problem

Cause

Solution

The camera
cannot power up.

There is no battery or the battery is
not inserted correctly.

Insert the battery correctly.

The battery has no power.

Replace the battery.

The battery power
is draining quickly.

The external temperature is
extremely low.

Many shots are being captured in
dark places, requiring a flash.

The battery or
camera is warm.

The camera or flash was used
continuously over a long period of
time.

The flash does not
fire or recharge.

The camera flash is turned off.

Set the flash to Auto Flash.

The light source is sufficient.

Even though the
flash fired, the
image is dark.

The distance to the subject is
greater than the flash's effective
range.

Get closer to the subject and shoot.

The image is too
bright or too dark.

The exposure is excessive or
inadequate.

Reset exposure compensation.

| cannot format a
memory card.

The memory card is write-
protected.

Remove the write protection.

End of the memory card life.

Insert a new memory card.

| cannot download
images from the
camera to my
computer.

The free space on the hard disk of
your computer is insufficient.

Ensure that the hard disk has
enough space for running Windows
and that the drive for loading image
files has free space equal to or
greater than the memory card in
the camera.

There is no power being supplied
to the camera.

Replace the battery.

English
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The camera does
not shoot even
when pressing the
shutter button.

The battery is running low.

Replace the battery.

The camera is not in the Capture
mode.

Switch to the Capture mode.

The shutter button was not pressed
all the way down.

Press the shutter button all the way
down.

The internal memory or memory
card does not have any free space.

Load a new card or delete
unwanted files.

The flash is recharging.

Wait until the flash mode icon,
indicated on the screen, stops
flashing.

The camera does not recognize the
memory card.

Format the memory card before the
initial use or before using with
another camera.

| cannot print
images with
PictBridge-

compliant printers.

The camera is connected to the
printer when the camera is
powered off.

Connect the camera to the printer,
turn on the camera, and then select
Printer.

Technical support
For technical assistance, free driver updates, product information, and news releases, visit
the following web site:

http://www.BenQ.com
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Specifications
Sensor Panasonic 14 Mega Pixels, 1/2.3 inch CCD
Zoom Optical: 5X

Digital: Up to 5X (Preview) / Up to 12X (Playback)
Lens f=4.7 (W)~23.5(T) mm

F:2.8 (W)~6.5(T)
f=26 mm ~ 130 mm, 35 mm equivalent

Focus Range

Normal: W = 15 cm ~ Infinity
Macro: W =15 cm ~ 100 cm

LCD

2.7” LCD 230k pixels

Image Resolution

« 14M (4320 x 3240)

- 3:2 (4320 x 2880)

- 8M (3264 x 2448) / 5M (2592 x 1944) / 3M (2048 x 1536) /
HD 16:9 (1920 x 1080 in full HD format) / VGA (640 x 480)

Movie Mode HD 720p (16:9; 1280 x 720; maximum video length: 29 minutes),
VGA (640 x 480), QVGA (320 x 240), or Web sharing (640 x 480)
30 fps
Continuous recording with sound

Shutter Speed 1/2000 ~ 1 sec (Fireworks 2 sec.; Manual, Night Scene 15 sec.)

White Balance

Auto, Daylight, Cloudy, Tungsten, Fluorescent H, Fluorescent L,
Manual

Exposure -2 ~+2 EV (0.3EV / step)
ISO * Auto /100 /200 /400 /800 / 1600
+ 1ISO 3200 for resolution of 3M or under only
* ISO 6400 for resolution of 3M or under only
Flash Auto Flash / Auto Anti Red-eye / Force On / Slow Sync / Force Off
Drive mode Off (Single) / 10 sec. (Self-timer) / 2 sec. (Self-timer) / Double / Burst /

Speedy Burst

Power Source

Two AA batteries
CIPA approximately 150 based on bundled AA batteries

Storage Type Built-in approx. 11.5 MB
4GB SD / 32GB SDHC card compatible
File Format Still Image: JPEG (EXIF 2.2 compatible); DCF compatible

Supported file formats:
* Video: MUPEG
* Audio: WAV

Dimensions / Weight

94.7 x61.0 x 21.4 mm
110 g (w/o battery & SD card)

Interface

Digital output: USB 2.0 compatible
Audio / Video output (NTSC/PAL)
PictBridge compatible

English
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Accessories

USB Cable / Software & User Manual CD / User Manual or Quick
Guide / Hand Strap / Non-rechargeable AA batteries

(3 All information, designs, and specifications are subject to change without prior notice.
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